Getting Started with SAS® Text Miner 3.1
# Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction to Text Mining and SAS Text Miner</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>What Is Text Mining?</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>What Is SAS Text Miner?</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>The Text Mining Process</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Accessibility Features of SAS Text Miner 3.1</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>Learning by Example: Text Mining Using SAS Text Miner 3.1</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>About the Scenario in This Book</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Prerequisites for This Scenario</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>How to Get Help for SAS Text Miner 3.1</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>Setting Up Your Project</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>About the Tasks that You Will Perform</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Create a Project</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Create a Data Source</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Create a Diagram</td>
<td>18</td>
</tr>
<tr>
<td>4</td>
<td>Analyzing the SYMPTOM_TEXT Variable</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>About the Tasks that You Will Perform</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Identify Input Data</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Partition the Input Data</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Set Text Miner Node Properties</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>View Interactive Results</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Examine Data Segments</td>
<td>28</td>
</tr>
<tr>
<td>5</td>
<td>Cleaning Up Text</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>About the Tasks that You Will Perform</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Use a Synonym Data Set</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Create a New Synonym Data Set</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Examine Results Using Merged Synonym Data Sets</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Create a Stop List</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>Explore Result Improvements</td>
<td>46</td>
</tr>
<tr>
<td>6</td>
<td>Predictive Modeling with Text Variables</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>About the Tasks that You Will Perform</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>Use the COSTRING Variable to Model</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>Use the SYMPTOM_TEXT Variable to Model</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>Compare the Models</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Additional Exercises</td>
<td>64</td>
</tr>
<tr>
<td>7</td>
<td>Next Steps: A Quick Look at Additional Features</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>The %TMFILTER Macro</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>The %TMPUNC Macro</td>
<td>65</td>
</tr>
</tbody>
</table>
Tips for Text Mining 66

Appendix 1 △ Recommended Reading 69
Recommended Reading 69

Appendix 2 △ Vaccine Adverse Event Reporting System Data Preprocessing 71
VAERS Data Preprocessing 71

Glossary 77

Index 81
What Is Text Mining?

Text mining helps you understand what textual documents tell you without having to read every word. Text mining uncovers the underlying themes or concepts that are contained in large document collections. Text mining applications fall into two areas: exploring the textual data for its content and then using the information to improve the existing processes. Both are important and can be referred to as descriptive mining and predictive mining.

Descriptive mining involves discovering the themes and concepts that exist in a textual collection. For example, many companies collect customers’ comments from sources that include the Web, e-mail, and call centers. Mining the textual comments includes providing detailed information about the terms, phrases, and other entities in the textual collection, clustering the documents into meaningful groups, and reporting the concepts that are discovered in the clusters. The result enables you to better understand the textual collection.

Predictive mining involves classifying the documents into categories and using the information that is implicit in the text for decision making. You might want to identify the customers who ask standard questions so that they receive an automated answer. Or you might want to predict whether a customer is likely to buy again, or even if you should spend more effort in keeping him or her as a customer.

Predictive modeling involves examining past data to predict future results. You might have a data set that contains information about past buying behaviors, along with comments that the customers made. You can then build a predictive model that can be used to score new customers: to analyze new customers based on the data from past customers. For example, if you are a researcher for a pharmaceutical company, you know that hand-coding adverse reactions from doctors’ reports in a clinical study is a laborious, error-prone job. Instead, you could create a model by using all your historical textual data, noting which doctors’ reports correspond to which adverse reactions. When the model is constructed, processing the textual data can be done automatically by scoring new records that come in. You would just have to examine the “hard-to-classify” examples, and let the computer handle all the rest.

Both of these aspects of text mining share some of the same requirements. Namely, text documents that human beings can easily understand must first be represented in a form that can be mined by the software. The raw documents need processing before the patterns and relationships that they contain can be discovered. Although the human
What Is SAS Text Miner?

SAS Text Miner is an add-on for the SAS Enterprise Miner environment. Enterprise Miner provides a rich set of data mining tools that facilitate the prediction aspect of text mining. The integration of SAS Text Miner within SAS Enterprise Miner combines textual data with traditional data mining variables. A Text Miner node can be embedded into a SAS Enterprise Miner process flow diagram. SAS Text Miner supports various sources of textual data: local text files, text as observations in SAS data sets or external databases, and files on the Web. The Text Miner node encompasses the parsing and exploration aspects of text mining and sets up the data for predictive mining and further exploration using other Enterprise Miner nodes. This enables you to analyze the new structured information that you have acquired from the text however you want, combining it with other structured data as desired.

The node is highly customizable and allows a variety of parsing options. It is possible to parse documents for detailed information about the terms, phrases, and other entities in the collection. You can also cluster the documents into meaningful groups and report the concepts that you discover in the clusters. All this is done in an environment that enables you to interact with the collection. Sorting, searching, filtering (subsetting), and finding similar terms or documents all enhance the exploration process.

The Text Miner node’s extensive parsing capabilities include

- stemming
- automatic recognition of multi-word terms
- normalization of various entities such as dates, currencies, percentages, and years
- part-of-speech tagging
- extraction of entities such as organizations, products, Social Security numbers, time, titles, and more
- support for synonyms

A secondary tool that Text Miner uses is a SAS macro that is called %TMFILTER. This macro accomplishes a text preprocessing step and allows SAS data sets to be created from documents that reside in your file system or on Web pages. These documents can exist in a number of proprietary formats.

With all this functionality, SAS Text Miner becomes a very flexible tool that can solve a variety of problems. Here are some examples of tasks that can be accomplished:

- filtering e-mail
- grouping documents by topic into predefined categories
- routing news items
- clustering analysis of research papers in a database
- clustering analysis of survey data
- clustering analysis of customer complaints and comments
- predicting stock market prices from business news announcements
- predicting customer satisfaction from customer comments
- predicting costs, based on call center logs.
The Text Mining Process

Whether you intend to use textual data for descriptive purposes, predictive purposes, or both, the same processing steps take place, as shown in Table 1.1.

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>File preprocessing</td>
<td>Creates a single SAS data set from your document collection. The SAS data set is used as input for the Text Miner node and may contain the actual text or paths to the actual text.</td>
<td>%TMFILTER macro—a SAS macro for extracting text from documents and creating a predefined SAS data set with a text variable</td>
</tr>
<tr>
<td>Text parsing</td>
<td>Decomposes textual data and generates a quantitative representation suitable for data mining purposes.</td>
<td>Text Miner node</td>
</tr>
<tr>
<td>Transformation (dimension reduction)</td>
<td>Transforms the quantitative representation into a compact and informative format.</td>
<td>Text Miner node</td>
</tr>
<tr>
<td>Document analysis</td>
<td>Performs clustering, classification, prediction, or concept linking of the document collection.</td>
<td>Text Miner node and/or Enterprise Miner predictive modeling nodes</td>
</tr>
</tbody>
</table>

Finally, the rules for clustering or predictions can be used to score a new collection of documents at any time.

You might not need to include all of these steps in your analysis, and it might be necessary to try a different combination of text-parsing options before you are satisfied with the results.

Accessibility Features of SAS Text Miner 3.1

SAS Text Miner 3.1 includes accessibility and compatibility features that improve usability of the product for users with disabilities. These features are related to accessibility standards for electronic information technology adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended. SAS Text Miner 3.1 supports Section 508 standards except as noted in the following table.
### Section 508 Accessibility Criteria

<table>
<thead>
<tr>
<th>Support Status</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported with exceptions.</td>
<td>The software supports keyboard equivalents for all user actions with the exceptions noted below:</td>
</tr>
<tr>
<td></td>
<td>- The keyboard equivalent for exposing the system menu is not the Windows standard Alt+spacebar. The system menu can be exposed using the following shortcut keys:</td>
</tr>
<tr>
<td></td>
<td>- Primary window - Shift+F10+spacebar</td>
</tr>
<tr>
<td></td>
<td>- Secondary window - Shift+F10+down key.</td>
</tr>
<tr>
<td></td>
<td>- The Explore action in the data source popup menu cannot be invoked directly from the keyboard, but there is an alternative way to invoke the data source explorer using the View ➤ Table menu.</td>
</tr>
<tr>
<td>Supported with exception.</td>
<td>Node run or failure indication relies on color, but there is always the corresponding message in the bottom right panel of the main window.</td>
</tr>
</tbody>
</table>

Color coding shall not be used as the only means of conveying information, indicating an action, prompting a response, or distinguishing a visual element.

If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.
CHAPTER 2

Learning by Example: Text Mining Using SAS Text Miner 3.1

About the Scenario in This Book

This book is intended for SAS Text Miner 3.1 users. Each topic in this book builds on the previous topic, so you must work through the chapters in sequence.

This book uses an extended example that is intended to familiarize you with the many features of Text Miner. Several key components of the Text Miner process flow diagram are covered. In this step-by-step example, you learn to do basic tasks in Text Miner: you create a project and build a process flow diagram. In your diagram, you perform tasks such as accessing data, preparing the data, building multiple predictive models using text variables, and comparing the models. The example is designed to be used in conjunction with SAS Text Miner 3.1 software.

The Vaccine Adverse Event Reporting System (VAERS) data is publicly available from the U.S. Department of Health and Human Services (HHS). Due to the Freedom of Information Act, anyone can download this data in comma-separated value (CSV) format from http://vaers.hhs.gov. There are separate CSV files for every year since the U.S. started collecting the data in 1991. This data is collected from anybody, but most reports come from vaccine manufacturers (42%) and health care providers (30%). Providers are required to report any contraindicated events for a vaccine or any very serious complications. Please see the Guide to Interpreting Case Report Information Obtained from the Vaccine Adverse Event Reporting System (VAERS) available at http://vaers.hhs.gov/info.htm.

See the following in the Getting Started with SAS Text Miner 3.1 zip file:

- ReportableEventsTable.pdf for a complete list of reportable events for each vaccine
- VAERS README file for a data dictionary and list of abbreviations used.

Note: See “Prerequisites for This Scenario” on page 10 for information on where to download the Getting Started with SAS Text Miner 3.1 zip file. △
The following figure shows the first 14 columns in the table of VAERS data for 2005. Included is a unique identifier, the state of residence, the recipient's age, and an unstructured text string SYMPTOM_TEXT containing the reported problem.

In analyzing adverse reactions to medications, both in clinical trials and in post-release monitoring of reactions, keyword- or word-spotting techniques combined with a thesaurus are most often used to characterize the symptoms. The Coding Symbols for Thesaurus of Adverse Reaction Terms (COSTART) has traditionally been the categorization technique of choice, but it has recently been largely replaced by the Medical Dictionary for Regulatory Affairs (MedDRA). COSTART is a term developed by the U.S. Food and Drug Administration (FDA) for the coding, filing, and retrieving of post-marketing adverse reports. It provides a keyword-spotting technique that deals with the variations in terms used by those who submit adverse event reports to the FDA.

In the case of vaccinations, the COSTART system is still used. The FDA uses a program to extract COSTART categories from the SYMPTOM_TEXT column. Here are some of the variables used by the program:

- SYMPTOM_TEXT—reported symptom text
- SYM01- SYM20—extracted COSTART categories
- SYM_CNT—number of SYM fields that are populated for a particular vaccination
- VAERS_ID—VAERS identification number.

Note that, from the figure here, VAERS_ID 231844 has SYMPTOM_TEXT of 101 fever, stiff neck, cold—the program has automatically extracted the COSTART terms FEVER, NECK RIG, PHARYNG, RHINITIS from this text.
The following figure shows other columns in the table, including a variety of flags that indicate the seriousness of the event (life-threatening illness, emergency room or doctor visit, hospitalized, disability, recovered), the number of days after the vaccine that the event occurred, how many different vaccinations were given, and a list of codes (VAX1-VAX8) for each of the shots given. There are also columns indicating where the shots were given, who funded them, what medications the patient was taking, and so on.

The README file taken from the VAERS Web site decodes the vaccine abbreviations. Note that some vaccinations contain multiple vaccines (e.g., DTP contains diphtheria, tetanus, and pertussis). Here is a portion of the README file:
In addition to explaining more about text mining and the kind of business problems it can address, this example demonstrates some of the key capabilities of SAS Text Miner 3.1.

As you go through this example, imagine you are a researcher trying to discover what information is contained within this data set and how you can use it to better understand the adverse reactions that children and adults are experiencing from their vaccination shots. These adverse reactions might be due to one or more of the vaccinations they are given, or they might be induced by an improper procedure from the administering lab (e.g., a non-sanitized needle). Some of them will be totally unrelated. For example, perhaps someone happened to get a cold just after receiving a
flu vaccine and reported it. You particularly want to look at serious reactions that required a hospital stay or caused a lifetime disability or death. You want to find answers to the following questions:

- What are some categories of reactions that people are experiencing?
- How do these relate to the vaccination that was given, the age of the recipient, the place they received the vaccine, or other pertinent information?
- What factors influence whether a reaction becomes serious?
- How well are these captured by the automatically extracted COSTART terms?
- Is there any important information contained in the adverse reaction text that is NOT represented by the COSTART terms?

When you are finished with this example, your process flow diagram should resemble the one shown here:
Prerequisites for This Scenario

By the time that you are ready to perform the tasks in this book, administrators at your site should have installed and configured all necessary components of SAS Text Miner 3.1. For details about the SAS Text Miner 3.1 postinstallation guide, see: http:/support.sas.com/documentation/onlinedoc/txtminer/postinstall31.pdf. You must also perform the following:

- Download the Getting Started with SAS Text Miner 3.1 data file in .zip format from the following URL: http://support.sas.com/documentation/onlinedoc/txtminer.
- Unzip this file into any folder in your file system.
- Create a folder called Vaersdata on your C:\ drive.
- Copy the following files into C:\Vaersdata:
  - Vaerext.Sas7bdat
  - Vaer_Abbrev.Sas7bdat
  - Engdict.Sas7bdat

How to Get Help for SAS Text Miner 3.1

Use any of the following methods to get Help for the SAS Text Miner 3.1:

- From the menu bar, select Help ▶ Contents
- Press F1 in most application windows.
About the Tasks that You Will Perform

To set up your project, you will perform the following main tasks:

1. You will create a new project where you will store all your work.
2. After the project is created, you will define the VAERS data as an Enterprise Miner data source.
3. You will create a new process flow diagram in your project.

Create a Project

To create a project, complete the following steps:

1. Open Enterprise Miner.
2. Click **New Project** in the Enterprise Miner window.
The Create New Project window opens. In the **Name** box, type a name for the project, such as **Vaccine Adverse Events**.
4 In the **Path** box, type the path to the location on the server where you want to store the data that is associated with the example project. Your project path depends on whether you are running Enterprise Miner as a complete client on your local machine or as a client/server application.

   If you are running Enterprise Miner as a complete client, your local machine acts as its own server. Your Enterprise Miner projects are stored on your local machine in a location that you specify, such as `C:\EM_Projects`.

   If you are running Enterprise Miner as a client/server application, all projects are stored on the Enterprise Miner server.

   If you see a default path in the **Path** box, you can accept the default project path, or you can specify your own project path. This example uses `C:\EM_Projects`.

5 Click the **Start-Up Code** tab and enter the following code to create a SAS library:

   ```
   libname vaers "c:\vaersdata";
   ```

   **Note:** The location will depend on where you have stored the data for this tutorial on your system. The example uses the local path specification, `C:\vaersdata`. △

6 Click **OK**. The new project is created and opens automatically.

   **Note:** Example results might differ from your results. Enterprise and Text Miner nodes and their statistical methods might incrementally change between releases. Your process flow diagram results might differ slightly from the results that are shown in this example. However, the overall scope of the analysis will be the same. △
Create a Data Source

To create a data source, complete the following steps:

1. Right-click the Data Sources folder in the Project panel and select Create Data Source to open the Data Source wizard.

2. In the Source box of the Data Source Wizard — Metadata Source window, select SAS Table to tell SAS Enterprise Miner that the data is formatted as a SAS table.

3. Click Next. The Data Source Wizard — Select a SAS Table window opens.

4. Click Browse in the Data Source Wizard — Select a SAS Table window. The Select a SAS Table window opens.
Double-click the SAS library named **VAERS**. The **VAERS** library folder expands to show all the data sets that are in the library. Select the **VAEREXT** table, and click **OK**. The two-level name **VAERS.VAEREXT** appears in the **Table** box of the Select a SAS Table window.
6 Click **Next**. The Table Information window opens. Examine the metadata in the Table Properties section.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>VAERS.VAEREXT</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Member Type</td>
<td>DATA</td>
</tr>
<tr>
<td>Data Set Type</td>
<td>DATA</td>
</tr>
<tr>
<td>Engine</td>
<td>V9</td>
</tr>
<tr>
<td>Number of Varia...</td>
<td>28</td>
</tr>
<tr>
<td>Number of Obs...</td>
<td>21073</td>
</tr>
<tr>
<td>Created Date</td>
<td>2006-10-17 13:4...</td>
</tr>
<tr>
<td>Modified Date</td>
<td>2006-10-17 13:4...</td>
</tr>
</tbody>
</table>

7 After you finish examining the table metadata, click **Next**. The Data Source Wizard — Metadata Advisor Options window opens.

8 Select **Advanced** and click **Next**.
9. The Data Source Wizard — Column Metadata window opens. Redefine these variable roles:
   - Set the role for \texttt{V_ADMINBY} to \textit{Input}.
   - Set the role for \texttt{V_FUNDBY} to \textit{Input}.
   - Set the role for \texttt{costing} to \textit{Text}.
   - Set the role for \texttt{serious} to \textit{Target}.

10. Click Next. The Decision Configuration window opens. Leave the default selection set to \textit{No}.

11. Click Next. The Data Source Attributes window opens.

12. Click Finish. The VAEREXT table is added to the Data Sources folder of the Project panel. You might need to expand the Data Sources folder to see the new table.
Create a Diagram

To create a diagram, complete the following steps:

1. Right-click the **Diagrams** folder of the Project panel and select **Create Diagram**.

2. Enter **VAERS Example** in the **Diagram Name** box and click **OK**.

   ![Diagram Example](image)

   The empty **VAERS Example** diagram opens in the diagram workspace.
About the Tasks that You Will Perform

The SYMPTOM_TEXT variable contains the text of the adverse event as it was reported. This is the variable that you will analyze using SAS Text Miner. You will perform the following tasks:

1. Use the Input Data node to identify the VAERS data source.
2. After adding the VAERS data source to your process flow diagram, you will use the Data Partition node to partition the input data.
3. Set some Text Miner node properties using the Properties panel.
4. View the results using the Interactive Results window.
5. Use the Segment Profile node to examine data segments.

Identify Input Data

To identify input data, complete the following step:

1. Select the VAEREXT data source from the Data Sources list in the Project panel.
   Drag and drop VAEREXT into the diagram workspace to create an Input Data node.
Partition the Input Data

To partition the input data, complete the following step:

1 Select the Sample tab from the node toolbar and drag a Data Partition node into the diagram workspace. Connect the Data Partition node to the VAEREXT Input Data node.

2 Select the Data Partition node to view its properties. Details about the node appear in the Properties panel. Set these Data Set Percentages properties as follows:
   - Set the Training property to 60.0.
   - Set the Validation property to 20.0.
   - Set the Test property to 20.0.

This will ensure adequate data when you build prediction models.

Set Text Miner Node Properties

To set the Text Miner node properties, complete the following steps:
1 Select the **Explore** tab on the toolbar and drag and drop a Text Miner node into the diagram workspace. Connect it to the Data Partition node.

![Diagram of Text Miner node connected to Data Partition node]

2 Select the Text Miner node to view its properties. Details about the node appear in the Properties panel. Set the following Parse properties:

- Set **Terms in Single Document** to **Yes**. This will include all terms that occur only in a single document.

- Set **Different Parts of Speech** to **No**. For the VAERS data, this setting offers a more compact set of terms.

- Click the ellipsis button to the right of the Synonyms property. The Select A SAS Dataset window opens. Select **No dataset to be specified** and click **OK**.

![Select A SAS Dataset window]

- Click the ellipsis button to the right of the Ignore Parts of Speech property, and select the following items, which represent parts of speech:
  
  - **Aux**
  - **Conj**
  - **Det**
  - **Interj**
  - **Part**
  - **Prep**
  - **Pron**
  - **Num**.

Any terms with these parts of speech that you select in this dialog box are ignored during parsing. The selections indicated here ensure that the analysis ignores low-content words such as prepositions and determiners.
3 Set the following Transform properties:

- Set **Term Weight** to **Mutual Information** so that terms will be differentially weighted when they correspond to serious reactions.

4 Set the following Cluster properties:

- Set **Automatically Cluster** to **Yes** to answer the question: "What are some categories of reactions that people are experiencing?" You want to categorize these adverse events.

- Set **Descriptive Terms** to **12**. This eases cluster labeling.
5 Right-click the Text Miner node in the diagram workspace, and select Run.  
6 Click Yes in the Confirmation window when you are prompted with Do you want to run this path?.  
7 After the Text Miner node has run, make sure that Parse Variable in the Property panel has been populated with the SYMPTOM_TEXT variable.

### View Interactive Results

To view interactive results, complete the following steps:

1 Click the ellipsis button to the right of the Interactive property to open the Interactive Results window. The Text Miner — Interactive window opens.
2 View the terms in the Terms window. The terms are sorted in decreasing order of occurrence.

<table>
<thead>
<tr>
<th>TERM</th>
<th>Freq</th>
<th># Docs</th>
<th>Keep</th>
<th>WEIGHT</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>have</td>
<td>6335</td>
<td>41.54</td>
<td>✔</td>
<td>0.084</td>
<td></td>
</tr>
<tr>
<td>receive</td>
<td>5191</td>
<td>3690</td>
<td>✔</td>
<td>0.059</td>
<td></td>
</tr>
<tr>
<td>vaccine</td>
<td>4628</td>
<td>34.30</td>
<td>✔</td>
<td>0.011</td>
<td></td>
</tr>
<tr>
<td>swell</td>
<td>3845</td>
<td>32.71</td>
<td>✔</td>
<td>0.221</td>
<td></td>
</tr>
<tr>
<td>day</td>
<td>3886</td>
<td>29.89</td>
<td>✔</td>
<td>0.011</td>
<td></td>
</tr>
<tr>
<td>arm</td>
<td>3956</td>
<td>20.80</td>
<td>✔</td>
<td>0.195</td>
<td></td>
</tr>
<tr>
<td>fever</td>
<td>2951</td>
<td>24.77</td>
<td>✔</td>
<td>0.022</td>
<td></td>
</tr>
<tr>
<td>leave</td>
<td>3104</td>
<td>24.60</td>
<td>✔</td>
<td>0.193</td>
<td></td>
</tr>
<tr>
<td>it</td>
<td>4339</td>
<td>24.55</td>
<td>✔</td>
<td>0.045</td>
<td></td>
</tr>
<tr>
<td>site</td>
<td>2681</td>
<td>22.56</td>
<td>✔</td>
<td>0.244</td>
<td></td>
</tr>
<tr>
<td>injection</td>
<td>2742</td>
<td>21.97</td>
<td>✔</td>
<td>0.204</td>
<td></td>
</tr>
<tr>
<td>report</td>
<td>3057</td>
<td>21.70</td>
<td>✔</td>
<td>0.046</td>
<td></td>
</tr>
<tr>
<td>patient</td>
<td>3726</td>
<td>20.06</td>
<td>✔</td>
<td>0.118</td>
<td></td>
</tr>
<tr>
<td>develop</td>
<td>2296</td>
<td>20.45</td>
<td>✔</td>
<td>0.022</td>
<td></td>
</tr>
<tr>
<td>give</td>
<td>2493</td>
<td>20.38</td>
<td>✔</td>
<td>0.078</td>
<td></td>
</tr>
</tbody>
</table>

3 View the documents in the Documents window. Click the Toggle Show Full Text icon at the far right of the toolbar to see the full text contained in SYMPTOM_TEXT.

---

Information has been received from an RN concerning a 54 year old white, obese Sabin tri vaccines were not good ones. They make you taller and handicapped too Cellulitus at administration site.

Denyelinating disease, dizziness, blurred vision, difficulty hearing and walking.

Autistic mannerisms, system "shutdown". Blank stares, catatonic state.

Loss of speech and coordination.

Reportedly called in after first dose to report had a rash that sounded like hives 2 Rash immediately following 03/21/1997 hep vaccine with arrested head growth an Large firm, red region at site of injection. Skin is itchy but not painful. Estimate 3 inc

This report is concerning a 4 month old female who on 23-NOV-2001 was vaccin Five to ten minute seizure, generalized. No meds given for seizure. On ampicillin a Fever for 3 days. Emesis (recurrent). Empiric antibiotics.

Fever, fussiness, questionable hematuria. 07/14: Right otitis media. 07/15: Persiste Temp 104. 5 within 24 hours of immunizations. Pt had septic URI admitted for 48 ho
4. View the clusters in the Clusters window.

5. Select a term that is related to an adverse reaction that you want to investigate further. In particular, select **fever** under the TERM column of the Terms window. Right-click on the term and select *Filter Terms*. 
Note how the documents displayed and cluster frequencies change. Only those documents containing fever are displayed. Moreover, only the documents containing fever are counted. If the full text of the document is not shown, click the Toggle Show Full Text icon on the right side of the toolbar.

Click the Undo icon on the toolbar. This removes the filter that was applied and restores the display that was shown when you opened the Interactive Results window.

Right-click on fever in the Terms window, and select View Concept Links. The Concept Linking window opens. Concept linking is a way to find and display the terms that are highly associated with the selected term in the Terms table. The selected term is surrounded by the terms that correlate the strongest with it. The Concept Linking window shows a hyperbolic tree graph with fever in the center of the tree structure. It shows you the other terms strongly associated with the term fever. In order to expand the Concept Linking view, right-click on any of the terms that are not in the center of the graph and select Expand Links.
9 Look at the clusters in the Clusters window. Can you tell what they are about from the descriptive terms displayed? Do some clusters look vague or unclear?

10 Choose one of the clusters that looks vague or unclear. This is fairly subjective, but for this example, you can use Cluster 2 as an example of a vague or unclear cluster. Right-click on Cluster 2 and select Filter Clusters. This action filters the results to show only those documents and terms that are relevant to Cluster 2. All the documents shown in the Documents window are contained in Cluster 2, and terms are now ordered by frequency within that cluster. Read the text of some of the documents in this cluster. Does this clarify the cluster better?
11 Click the Undo icon on the toolbar to undo any filters.

12 Close the Interactive Results window.

Examine Data Segments

In this section, you will examine segmented or clustered data using the Segment Profile node. A segment is a cluster number derived analytically using SAS Text Miner clustering techniques. The Segment Profile node enables you to get a better idea of what makes each segment unique or at least different from the population. The node generates various reports that aid in exploring and comparing the distribution of these factors within the segments and population.

To examine data segments, complete the following steps:

1 From the Assess tab, drag and drop the Segment Profile node into the diagram workspace and connect it to the Text Miner node.

2 Select the Segment Profile node. On the Properties panel, select the ellipsis button to the right of the Variables property. The Variables — Prof window opens.
3 Select all the PROB variables and set their **Use** to **No**.

4 Select all the _SVD_ variables and also set their **Use** to **No**.

5 Click **OK**.
6 Select the Segment Profile node in the diagram workspace. In the Properties panel, set **Minimum Worth** to **0.0010**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Variables</td>
<td></td>
</tr>
<tr>
<td>Number of Inputs</td>
<td>10</td>
</tr>
<tr>
<td>Minimum Worth</td>
<td>0.0010</td>
</tr>
<tr>
<td>Print Worth Statistics</td>
<td>Yes</td>
</tr>
</tbody>
</table>

7 Run the Segment Profile node.
8 After the node finishes running, click **Results** in the Run Status window.
9 Maximize the Profile: **_CLUSTER_** window.

The Results — Segment Profile window displays a lattice, or grid, of plots comparing the distribution for the identified and report variables for both the segment and the population. The graphs shown in this window are variables that have been identified as factors that distinguish the segment from the population it represents. Each row represents a single segment. The far-left margin identifies the segment, its count, and the percentage of the total population. By default, the rows are sorted in ascending size order from top to bottom.

The columns are organized from left to right according to their ability to discriminate that segment from the population. Report variables, if specified, appear on the right in alphabetical order after the selected inputs. The lattice graph has the following features:

- **Class variable**—displays as two nested pie charts that consist of two concentric rings. The inner ring represents the distribution of the total population. The outer ring represents the distribution for the given segment.
Interval variable—displays as a histogram. The blue shaded region represents the within-segment distribution. The red outline represents the population distribution. The height of the histogram bars can be scaled by count or by percentage of the segment population. When you are using the percentage, the view shows the relative difference between the segment and the population. When you are using the count, the view shows the absolute difference between the segment and the population.

In the example, note the strong relationships between some of the vaccinations given and the clustered categories (e.g., Diptheria/Tetanus and Segment 8 or HIB and Segment 4). You can think of the "wheels" or concentric rings as follows: the inner circle represents all the adverse events, while the outer circle contains only the ones in that cluster. Position your mouse over an area, and it displays the value associated with that color. Double-click the top cluster labeled Diptheria/Tetanus. The cluster occurs with Diptheria/Tetanus about 66 percent of the time as compared to only about 47 percent of the time in the total population.
CHAPTER 5

Cleaning Up Text

About the Tasks that You Will Perform

Use a Synonym Data Set
Create a New Synonym Data Set
Examine Results Using Merged Synonym Data Sets
Create a Stop List
Explore Result Improvements

About the Tasks that You Will Perform

Some clusters in the previous chapter’s results probably seemed pretty logical and dealt with an interesting theme. But some clusters were probably duplicates of others, and some might have seemed a hodgepodge of different things. SAS Text Miner does a good job of finding themes that are clear in the data. When the data needs cleaning, SAS Text Miner is not as effective at uncovering useful themes. Analyzing messy data that needs cleaning is more common than analyzing clean data. In this example, you will deal with manually edited data with many misspellings and abbreviations. In this chapter, you will work on cleaning up the data to get better results.

The README.TXT file provided on the VAERS site contains a list of commonly used abbreviations in the adverse event reports. SAS Text Miner allows you to specify a synonym list for use in the tool. A VAER_ABBREV synonym list is provided for you in the Getting Started with SAS Text Miner 3.1 zip file. To create such a synonym list, the abbreviations list from README.TXT was copied into MS Excel. The list was manually edited there and then imported into a SAS data set. For example, CT/CAT was marked as equivalent to computerized axial tomography. For more information about the preprocessing steps, see Appendix 2, “Vaccine Adverse Event Reporting System Data Preprocessing,” on page 71.

For more information about importing data into a SAS data set, see Importing and Exporting Data in the following URL: http://support.sas.com/onlinedoc/913/docMainpage.jsp.
### Abbrev Vaccine Type

<table>
<thead>
<tr>
<th>Abbrev</th>
<th>Vaccine Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADEN</td>
<td>ADENOVIRUS VACCINE LIVE ORAL TYPE 7</td>
</tr>
<tr>
<td>ANTH</td>
<td>ANTHRAX VACCINE</td>
</tr>
<tr>
<td>BCG</td>
<td>BACTILLUS CALMETTE-GUERIN VACCINE</td>
</tr>
<tr>
<td>CHOL</td>
<td>CHOLERA VACCINE</td>
</tr>
<tr>
<td>DT</td>
<td>DIPHTHERIA AND TETANUS TOXIDS, PED</td>
</tr>
<tr>
<td>DTAP</td>
<td>DIPHTHERIA AND TETANUS TOXIDS AND</td>
</tr>
<tr>
<td>DTAP</td>
<td>TETRAMUNE</td>
</tr>
<tr>
<td>DTP</td>
<td>DT-IPV COMBINED DT AND IPV VACCINE</td>
</tr>
<tr>
<td>DTP</td>
<td>DIPHTHERIA TOXOID</td>
</tr>
<tr>
<td>DTP</td>
<td>DIPHTHERIA AND TETANUS TOXIDS AND</td>
</tr>
<tr>
<td>DTP</td>
<td>COMBINATION OF DTP, IPV and ACT-HIB</td>
</tr>
<tr>
<td>DTP</td>
<td>IPV COMBINED DTP AND IPV VACCINE</td>
</tr>
<tr>
<td>FLU</td>
<td>INFLUENZA VIRUS VACCINE</td>
</tr>
<tr>
<td>HBHEPB</td>
<td>COMVAX</td>
</tr>
<tr>
<td>HBPV</td>
<td>HAEMOPHILUS B POLYSACCHARIDE VACCINE</td>
</tr>
<tr>
<td>HEPB</td>
<td>HEPATITIS B VIRUS VACCINE</td>
</tr>
<tr>
<td>HEPA</td>
<td>HEPATITIS A</td>
</tr>
<tr>
<td>HIBV</td>
<td>HAEMOPHILUS B CONJUGATE VACCINE</td>
</tr>
<tr>
<td>IPV</td>
<td>POLIOVIRUS VACCINE INACTIVATED</td>
</tr>
<tr>
<td>JEV</td>
<td>JAPANESE ENCEPHALITIS VIRUS VACCINE</td>
</tr>
<tr>
<td>M</td>
<td>MEASLES VIRUS VACCINE, LIVE</td>
</tr>
<tr>
<td>M-RV</td>
<td>RUBEOVAX-LIVE MEASLES DISCONTINUED</td>
</tr>
<tr>
<td>MEN</td>
<td>MENINGOCOCCAL POLYSACCHARIDE VACCINAN</td>
</tr>
<tr>
<td>MM</td>
<td>MEASLES AND MUMPS VIRUS VACCINE, LI</td>
</tr>
<tr>
<td>MMR</td>
<td>MEASLES, MUMPS AND RUBEELLA VIRUS VACCIAN</td>
</tr>
</tbody>
</table>

### VAERS VAER_ABBREV - Rows 1 - 100

<table>
<thead>
<tr>
<th>TERM</th>
<th>PARENT</th>
<th>CATEGORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>a/</td>
<td>before</td>
<td></td>
</tr>
<tr>
<td>abd</td>
<td>abdomen</td>
<td></td>
</tr>
<tr>
<td>abn</td>
<td>abnormal</td>
<td></td>
</tr>
<tr>
<td>addl</td>
<td>additional</td>
<td></td>
</tr>
<tr>
<td>adm</td>
<td>admitted</td>
<td></td>
</tr>
<tr>
<td>admission</td>
<td>admitted</td>
<td></td>
</tr>
<tr>
<td>ADR</td>
<td>adverse drug reaction</td>
<td></td>
</tr>
<tr>
<td>ADL</td>
<td>activities of daily living</td>
<td></td>
</tr>
<tr>
<td>AE</td>
<td>Adverse Event</td>
<td></td>
</tr>
<tr>
<td>afrob</td>
<td>arebrile</td>
<td></td>
</tr>
<tr>
<td>AKA</td>
<td>also known as</td>
<td></td>
</tr>
<tr>
<td>alk phosph</td>
<td>alkaline phosphatase</td>
<td></td>
</tr>
<tr>
<td>allerg</td>
<td>allergy</td>
<td></td>
</tr>
<tr>
<td>allergic</td>
<td>allergy</td>
<td></td>
</tr>
<tr>
<td>ALT</td>
<td>serum glutamic pyruvic transaminase</td>
<td></td>
</tr>
<tr>
<td>AMA</td>
<td>American Medical Association</td>
<td></td>
</tr>
<tr>
<td>amb</td>
<td>ambulate</td>
<td></td>
</tr>
<tr>
<td>ambulance</td>
<td>ambulate</td>
<td></td>
</tr>
<tr>
<td>amnt</td>
<td>amount</td>
<td></td>
</tr>
<tr>
<td>ANA</td>
<td>antinuclear antibody</td>
<td></td>
</tr>
</tbody>
</table>
You will perform the following tasks to clean up the text and examine the results:
1. Use a synonym data set provided for you in the Getting Started with SAS Text Miner 3.1 zip file.
2. Create a new synonym data set using the SAS Code node and the %TEXTSYN macro. The %TEXTSYN macro will run through all the terms, automatically identify which ones are misspellings, and create synonyms mapping them to the misspelled terms.
3. Examine results using merged synonym data sets.
4. Create a stop list to define which words are removed from the analysis. A stop list is a simple collection of low-information or extraneous words that you want to remove from the text, which has been saved as a SAS data set.
5. Explore whether cleaning up the text improved the clustering results.

**Use a Synonym Data Set**

To use a synonym data set, complete the following steps:

1. Right-click the original Text Miner node and select Copy. Right-click in the empty diagram workspace and select Paste.
2. To distinguish this newly pasted Text Miner node from the first node, right-click on it, select Rename and name it Text Miner - Symptom Text. Click OK in the Rename window.
3. Connect the Data Partition node to the new Text Miner - Symptom Text node.
4. Select the Text Miner - Symptom Text node in the diagram workspace. In the Properties panel, click the ellipsis to the right of Synonyms. The Select A SAS Dataset window opens.
5 Double-click the VAERS library to expand it, select VAER_ABBREV, and click OK.

![Select A SAS Dataset](image)

6 Leave all other settings the same as in the original Text Miner node.

![Text Miner - Symptom Text](image)

7 Select the Text Miner - Symptom Text node in the diagram workspace and run the node.

8 Click the ellipsis to the right of the Interactive property to open the Interactive Results window.

9 Click the TERM column heading to sort the Terms table.

10 Select abdomen under the TERM column in the Terms window. The term abdomen is one of the terms on the right hand side of the VAERS.VAER_ABBREV table. In the Terms window, there should be a plus (+) sign next to abdomen. Click on the plus sign to expand the term. This shows all synonyms and stems that are mapped to that term. A stem is the root form of a term. Make sure that the child term abd is included. SAS Text Miner is now treating all these terms the same.
Close the Interactive Results window.

Create a New Synonym Data Set

You will use the SAS Text Miner %TEXTSYN macro to create a new synonym data set. The macro will run through all the terms, automatically identify which ones are misspellings, and create synonyms mapping them to the misspelled term. To create a new synonym data set, complete the following steps:

1. Select the Utility tab and drag a SAS Code node into the diagram workspace. Connect this node to the Text Miner - Symptom Text node. Rename the SAS Code node to SAS Code - %TEXTSYN.

2. Select the arrow that connects the Text Miner - Symptom Text node with the SAS Code - %TEXTSYN node. Note the value of the Terms export Table property. You will use this value in the TERMS= parameter in the next step.

   Note: The libname EMWS in the Terms export Table property is dependent upon the diagram number within your Enterprise Miner project. If your diagram is the first one created, the libname will be EMWS, the second diagram will be EMWS1, the third will be EMWS2, and so on. △
3 Select the SAS Code - %TEXTSYN node and click the ellipsis to the right of the SAS Code property in the Properties panel.

4 Enter the following code in the SAS Code tab:

```
%textsyn( termds=emws.text2_terms
    , docds=&em_import_data
    , outds=&em_import_transaction
    , textvar=symptom_text
    , mnpardoc=8
    , mxchddoc=10
    , synds=vaers.vaerextsyns
    , dict=vaers.engdict
    , maxsped=15
  );
```
5 Click **OK** and run the SAS Code - %TEXTSYN node.

6 From the Enterprise Miner window, select **View ▶ Table**. The Select a SAS Table window opens.

7 Double-click **VAERS**, select **VAEREEXTSYNS**, and click **Explore**. The Explore window opens.

   **Note:** If the **VAERS** library is already expanded, you might need to click **Refresh** to see the **VAEREEXTSYNS** data set.
8 Examine the VAERS.VAEREXTSYNS table.

<table>
<thead>
<tr>
<th>#</th>
<th>OBJ</th>
<th>EXAMPLE</th>
<th>TERM</th>
<th>PARENT</th>
<th>CATEGORY</th>
<th>CHILNDOC</th>
<th># DOCUMENTS</th>
<th>MINGED</th>
<th>DICT</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>abdomin abdomin *submitting Typval MISO...</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>abdomin abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>abdomin abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>abdomin abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>abdomin abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>abdomin abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td>abdomin</td>
<td></td>
</tr>
</tbody>
</table>

Here is a list of what the VAEREXTSYNS columns provide:
- **Term** is the misspelled word.
- **PARENT** is an intelligent guess at the word that was meant.
- **CHILNDOCs** is the number of documents that contained that term.
- **# Documents** is the number of documents that contained the parent.
- **MINGED** is an indication of how close the terms are.
- **DICT** indicates whether the term is a legitimate English word. Legitimate words can still be deemed misspellings, but only if they occur rarely and are very close in spelling to a frequent target term.
- **EXAMPLE1** and **EXAMPLE2** are two examples of the term in a document.

For example, Observation 66 shows **abdomin** to be a misspelling of **abdominal**. Three documents contain **abdomin**, 84 documents contain the parent, **abdomin** is not a legitimate English word, and an example text that contains that misspelling is **20 mins later, upper !!abdomin!! an...** Note that double exclamation marks (!!) both precede and succeed the child term in the example text so you can see the term in context.

9 Examine this table to see if you disagree with some of the choices made. For this example, however, assume the %TEXTSYN macro has done a good enough job detecting misspellings.

**Note:** The table could be edited using any SAS table editor. You cannot edit this table in the SAS Enterprise Miner Java client. You could change a parent for any misspellings that appear incorrect or delete a row if the Term column contains a valid term. Make sure to save any changes you made.△

10 Close the VAERS.VAEREXTSYNS table and the Select a SAS Table window.

---

**Examine Results Using Merged Synonym Data Sets**

In this set of tasks, you will create a new data set that contains all the observations from both the VAERS.VAEREXTSYNS and VAERS.VAER_ABBREV data sets. You will also examine results using merged synonym data sets. Complete the following steps:

1 Select the **Utility** tab and drag a SAS Code node into the diagram workspace. Connect this new SAS Code node to the existing SAS Code - %TEXTSYN node. Rename the new SAS Code node to SAS Code - Merge Synonym Lists.
2 Select the SAS Code - Merge Synonym Lists node and click the ellipsis to the right of the **SAS Code** property in the Properties panel.

3 Enter the following code in the **SAS Code** tab:

```sas
data vaers.vaerextsyns_new;
   set vaers.vaerextsyns vaers.vaer_abbrev;
run;
```

This code merges the resulting synonyms data set from the first SAS Code - %TEXTSYN node with the abbreviations data set.

4 Run the SAS Code — Merge Synonym Lists node. Click **Results** in the Run Status window.

5 From the Results window, select **View** → **SAS Results** → **Log**. The following display shows the SAS code where the new data set is created.

6 Copy and paste the Text Miner - Symptom Text node and rename it Text Miner - Cleaned Symptom Text.

7 Connect it to the Data Partition node.
8 Select the Text Miner - Cleaned Symptom Text node. Set the following properties in the Properties panel:

- Click the ellipsis to the right of the Synonyms property. Select VAERS.VAEREXTSYN_NEW from the Select A SAS Dataset window.
- Set Terms in a Single Document back to No.

9 Run the Text Miner - Cleaned Symptom Text node.

10 Click OK in the Run Status window.

11 Click the ellipsis to the right of the Interactive property in the Text Miner - Cleaned Symptom Text node Properties panel. The Interactive Results window opens.

12 Select +patient in the Terms table. Note that the misspellings patien, patietn, and patie are included as child terms.
Create a Stop List

A stop list is a simple collection of low-information or extraneous words that you want to remove from the text, which has been saved as a SAS data set. To create a stop list, complete the following steps:

1. Click the Freq column heading to sort the Terms table by the frequency. Make sure that the Freq label has an arrow that points downward to indicate that the Freq column is sorted in descending order.

2. Drop some terms that really have no bearing on what the adverse reaction is. Hold down the CTRL key and click on these terms: patient, have, receive, vaccine, day, develop, and dose. Right-click to invoke the pop-up menu. Select Toggle KEEP to uncheck the Keep attribute. This removes the checkmark from the Keep column for each term you have selected.

There are several more terms you could choose to exclude. Only a few are itemized here to demonstrate the concept and process. If additional terms are dropped from the analysis, note that different results will be obtained that will not match those later in this document.
3 Double-click the # Docs column heading and ensure that the sort arrow is pointing upward. This sorts the terms by count.

4 Click and drag the mouse to select all terms with counts of 2. Right-click and select **Toggle KEEP** so that these terms are dropped from the analysis.

5 Select **File ▶ Save Stop List**.
6 Select the VAERS library and type VAEREXTSTOP in the Dataset Name box.

7 Click OK.

8 Close the Text Miner — Interactive Results window.
Explore Result Improvements

You will redo the clustering to explore the improvements to results from cleaning the SYMPTOM_TEXT variable. Complete the following steps:

1. Verify that the Cluster property settings for the Text Miner - Cleaned Symptom Text node are the same as in previous examples.

2. Run the Text Miner - Cleaned Symptom Text node to redo the clustering.
3 Open the Interactive Results window and look at the Clusters table.

<table>
<thead>
<tr>
<th>Clusters</th>
<th>Descriptive Terms</th>
<th>Freq</th>
<th>Percentage</th>
<th>RMS Std</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>episode, + week, + old, + year, + report, + minute, + experience, + female, + symptom, + feel, + emergency room, + time</td>
<td>1520</td>
<td>0.131962830...</td>
<td>0.1535012...</td>
</tr>
<tr>
<td>2</td>
<td>infant, + diagnosis, loss, + diagnose, + month, + late, + child, + vaccination, + symptom, + experience, + see, + information</td>
<td>975</td>
<td>0.077196857...</td>
<td>0.1503808...</td>
</tr>
<tr>
<td>3</td>
<td>elbow, injection site, + upper, + swell, warmth, + itch, + pain, + injection, + delirious, + arm, + leave arm, + leave</td>
<td>2510</td>
<td>0.158526830...</td>
<td>0.1048913...</td>
</tr>
<tr>
<td>4</td>
<td>emergency room, + seizure, + discharge, + admit, + hospital, + home, + minute, + temperature, + child, + call, + date, + give</td>
<td>767</td>
<td>0.062247004...</td>
<td>0.1252533...</td>
</tr>
<tr>
<td>5</td>
<td>emergency room, + benadryl, + feel, + start, + slate, + give, + hour, + seas, + hve, + fever, + rash, + face</td>
<td>2687</td>
<td>0.212526671...</td>
<td>0.1198837...</td>
</tr>
<tr>
<td>6</td>
<td>febrile seizure, + minute, + fever, + fe brile, + activity, + seizure, + emergency room, + generalize, + second, + last, + immunization, + temperature</td>
<td>239</td>
<td>0.018903741...</td>
<td>0.0389636...</td>
</tr>
<tr>
<td>7</td>
<td>hospitalize, + information, + antibiotic, + vaccinate, + year, + recover, mal, + cold, + seizure, + report, + physician, + female</td>
<td>171</td>
<td>0.013525270...</td>
<td>0.0062450...</td>
</tr>
<tr>
<td>8</td>
<td>physician, + unspecific, medical history, + concurrent, + medical, + old, males, + allergy, + include, + report, + virus, + lot</td>
<td>912</td>
<td>0.072134778...</td>
<td>0.0913942...</td>
</tr>
<tr>
<td>9</td>
<td>leave, + red, hot, tender, + swell, + delirious, + touch, + erythema, + size, + right, + upper, + site</td>
<td>1563</td>
<td>0.123826721...</td>
<td>0.1038602...</td>
</tr>
</tbody>
</table>

4 Compare these results to the first Text Miner node results from Chapter 4, “Analyzing the SYMPTOM_TEXT Variable,” on page 19. Does the clustering seem to have improved with the cleaned SYMPTOM_TEXT data?

5 Copy the old Segment Profile node, and paste it next to the Text Miner — Cleaned Symptom Text node.
6 Connect the Text Miner — Cleaned Symptom Text node to this Segment Profile (2) node.

7 Click the **Variables** property for the Segment Profile (2) node. Make sure that the PROB variables and the SVD variables are set to **Use=No**.

8 Run the Segment Profile (2) node.

9 View the resulting profiles. Note the significant relationships in the table. Explore your results and note anything that seems of particular interest to you about the problem you are trying to solve, such as areas you’d like to explore further at a later time.
10 Do the relationships appear clearer with the cleaned text than they did with the uncleaned text?
About the Tasks that You Will Perform

Long before text mining, researchers have needed to analyze text. In the field of drug trials, the need was acute enough that coding systems were developed to automatically pull out keywords or synonyms of keywords that could then be analyzed to understand adverse events. The COSTART coding system was one such attempt. COSTART terms consist of one to three tokens: a symptom, an optional body part, and an optional subpart. One of your initial tasks was to find what factors influence whether a reaction becomes serious and how well these are captured by the COSTART terms. One way of doing this is to use SAS Text Miner to see how well the COSTART terms predict how serious the adverse event was. This is called predictive modeling, and it is the goal of this chapter.

To analyze texts with predictive models, you will perform the following tasks:

1. Use the COSTRING variable and the Decision Tree node to create a model.
2. Use the SYMPTOM_TEXT variable and the Decision Tree node to create a model.
3. Compare the models using the Model Comparison node.

Use the COSTRING Variable to Model

To use the COSTRING variable to create a model, complete the following steps:

1. Select the Explore tab on the toolbar and drag and drop a Text Miner node into the diagram workspace. Connect it to the Data Partition node.

2. To distinguish it from other Text Miner nodes, rename this new node Text Miner - COSTART Terms.
Select the node named VAEREXT in the diagram workspace. Click the ellipsis to the right of the **Variables** property in the Properties panel.

Recall that there were two text variables, COSTRING and SYMPTOM_TEXT, from the initial data source. By default, SAS Text Miner will use the longer text variable, SYMPTOM_TEXT. In this chapter, you want to mine the COSTRING variable.
4 Select the Text Miner - COSTART Terms node. Set the following properties in the Properties panel:
   - Click the ellipsis to the right of the Variables property. In the Variables window, set `SYMPTOM_TEXT` to `Use=No`, `costring` to `Use=Yes`, and `serious` to `Use=Yes`. 
     Click **OK** to save your changes.

   - Click the ellipsis to the right of the Stop List property. Select the **No dataset to be specified** check box in the Select A SAS Dataset window. This removes the entry for the stop list so that no stop list is used. Click **OK**.

   - Set **Different Parts of Speech** to **No**.

5 Run the Text Miner - COSTART Terms node.

6 In the Properties panel, make sure that the Parse Variable property of the Text Miner - COSTART Terms node is set to `costring`.

7 Click the ellipsis to the right of the Interactive property to open the Interactive Results window. One problem with COSTART is that it does not always use the same keyword to describe the same term or equivalent terms. For example,
**abdomen** is shown in COSTART as *ab* and as *abdo*. Sometimes there are modifiers that you do not need. You could run the %TEXTSYN macro, but because these are abbreviations, the macro will probably not find all of the correct spellings. You need to manually clean some terms.

8 Sort the terms in the Terms window by clicking on the Term column heading. Clean the COSTART data by fixing these differences. Select *ab*, *abd*, and *abdo* from the TERM column. Right-click and select **Treat as Equivalent Terms**.

<table>
<thead>
<tr>
<th>Terms</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>TERM</td>
<td>Freq</td>
<td>x Docs</td>
<td>Keep</td>
<td>WEIGHT</td>
<td>Role</td>
<td>Attribute</td>
</tr>
<tr>
<td>ab</td>
<td>21</td>
<td>6</td>
<td>✔️</td>
<td>0.78</td>
<td>Alpha</td>
<td>Alpha</td>
</tr>
<tr>
<td>ab pain</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
<tr>
<td>abd</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>Alpha</td>
<td>Alpha</td>
</tr>
<tr>
<td>abdo</td>
<td>163</td>
<td></td>
<td></td>
<td></td>
<td>Alpha</td>
<td>Alpha</td>
</tr>
<tr>
<td>abdo pain</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
<tr>
<td>abdo pain chest</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
<tr>
<td>abdo pain neck</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
<tr>
<td>abdo pellir</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
<tr>
<td>abdo paresthesia</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
<tr>
<td>abdo paresthesia r</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>GROUP</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

Select *abdo* from the Create Equivalent Terms window. Click **OK**.

Look through the data set and create synonyms by holding the CTRL or Shift keys and clicking the terms that you consider to be the same. Then, right-click on these selected terms and select **Treat as Equivalent Terms**.

9 Repeat this process as many times as you need. It might be helpful to filter the terms so that you can view the full text of COSTART before combining terms.

10 Select **File ▶ Save Synonyms** from the Interactive Results window menu. Save your changes as VAERS.COSTARTSYNS.
11 Close the Interactive Results window.

12 Note that the Synonyms property in the Properties panel has been set to the new VAERS.COSTARTSYNS synonym data set.

13 COSTART terms should represent keywords, so you want to create variables for each keyword. Set the following Transform properties on the Properties panel:

- Set Compute SVD to No.
- Set Term Weight to Mutual Information.
- Set Roll up Terms to Yes.
- Set No. of Rolled-up terms to 400.
- Set Drop Other Terms to Yes.
14 Rerun the Text Miner - COSTART Terms node using the newly created synonym list.

15 Open the Interactive Results window and view the resulting Terms window.

16 Sort the TERM column until the arrow on the column heading is pointing down. Note that terms with a plus (+) sign indicate the synonyms you have specified. Click the + sign to expand the child terms underneath the representative parent term.

17 Scroll down until you see terms that do not have a checkmark beneath the Keep column. A separate variable will not be created for these terms. They were not considered significant enough (based on only rolling up 400 variables) to create a separate variable. Recall that you set the Roll up Terms property to Yes and No. of Rolled-up Terms to 400. When you roll up terms, the terms are sorted in descending order of the value of the term weight times the square root of the number of documents. The top 400 highest-ranked terms are then used as variables on the document collection.

18 Close the Interactive Results window.
19 From the Model tab, drag and drop a Decision Tree node and connect it to the Text Miner - COSTART Terms node. Later on you will use another Decision Tree node. To distinguish them, rename this node Decision Tree - COSTART Terms.

20 Run the Decision Tree - COSTART Terms node with the default settings. Click Yes in the Confirmation window. Recall that when you created the VAEREXT data set, you set serious as the target variable.

21 When the node has run, click Results in the Run Status window to explore the results.

22 Select View ➤ Assessment ➤ Classification Chart: serious from the menu at the top of the Results - Decision Tree - COSTART Terms window to view the Classification Chart.

Note: Red indicates correct classification and blue indicates incorrect classification. The Decision Tree model does an excellent job of classifying the adverse events that are not considered serious. The model correctly predicts half of them to be serious and half of them to be minor. △
Use the SYMPTOM_TEXT Variable to Model

To use the SYMPTOM_TEXT variable to create a model, complete the following steps:

1. Copy the Text Miner - Cleaned Symptom Text node and connect it to the Text Miner - COSTART Terms node.
This second Text Miner - Cleaned Symptom Text node will be used to analyze the SYMPTOM_TEXT variable. SYMPTOM_TEXT will be the default parse variable because it is the longest text field in the data set. So you need to specify COSTRING as a variable as well. Select the second Text Miner - Cleaned Symptom Text node and click on the Variables property in the Properties panel.

In the Variables window, set the following:
- Set SYMPTOM_TEXT to Use=Yes.
- Set costing to Use=Yes.
- Set serious to Use=Yes.

Set the following Text Miner - Cleaned Symptom Text node properties in the Properties panel:
- Set Compute SVD to Yes.
- Set SVD Resolution to Low.
- Set Term Weight to Mutual Information.

Run the Text Miner - Cleaned Symptom Text node.
From the **Model** tab, drag and drop a Decision Tree node and connect it to the Text Miner - Cleaned Symptom Text node. You will use the decision tree to see whether text mining the original text can do a better job of predicting serious events than just mining the COSTART terms.

Rename this node Decision Tree - Symptom Text.

Click the **Variables** property in the Decision Tree - Symptom Text Properties panel. The Variable window opens.

Click and scroll to select all of the \_ROLL\_ variables and set them to **Use=No**.

Click **OK** to save your changes.

Run the Decision Tree - Symptom Text node. Click **OK** in the Run Status window.

From the **Model** tab, drag and drop a Decision Tree node and connect it to the Text Miner - Cleaned Symptom Text node.

Rename this new Decision Tree node Decision Tree - COSTART + Symptom Text. This node will let you see how well you can predict serious events with all the information available to you. Use the default settings for the node.
Compare the Models

To compare the models, complete the following steps:

1. From the **Assess** tab, drag and drop a Model Comparison node and connect all three Decision Tree nodes to it. This allows you to compare the performance of the three different models. Your diagram should look something like the following:

2. Run the Model Comparison node and click **Results** in the Run Status window to view the results.

3. Click the ROC Chart to maximize the window.
The greater the area under the curve, the better the model. The red line shows the results of the model using COSTART terms, the green line shows the results of the SYMPTOM_TEXT terms, and the brown line shows the results of the combined COSTART and SYMPTOM_TEXT terms. The worst model uses only the COSTART terms, while the best model uses the combination of COSTART and SYMPTOM_TEXT. Apparently, text mining can add information not contained in the COSTART terms. The text mining model provides better results than the keyword-based model. Combining the models offers the best results.

4 Select View ➪ Assessment ➪ Classification Chart from the pull-down menu at the top of the Results window to view the Classification Chart.

Note: Red indicates correct classification and blue indicates incorrect classification. In the combined model, the majority of serious events are now classified as serious.
5 Close the Model Comparison Results window. It would be useful to see which variables are most important in the combined model for predicting serious events.

6 Right-click on the Decision Tree - COSTART + Symptom Text node and select Results to view the results of the combined Decision Tree models.

7 Click the Output window to maximize it. Scroll through the output to the Variable Importance results.

   Note: The SVD terms are more important than the individual terms themselves in predicting a serious adverse event.

Interestingly, none of the demographic information, such as the patient’s age or sex, improves a model that consists entirely of textual data. None of these variables are listed in the Variable Importance results.
You have looked at predicting the seriousness of adverse events. To explore additional exercises, complete the following steps:

1. You might want to look at the types of adverse events that occur. Try the following:
   - See if you can use the COSTART analysis to predict the clusters you obtained from analyzing the SYMPTOM_TEXT variable. You can do this with the Cluster node. To combine variables together, you might want to try a Decision Tree node.
   - The original data contains other variables, such as medications and lab tests. You know that the type of adverse events is affected by drug interactions. Using the original data, see if you can text mine the medications field to roll up variables for the medications patients are currently taking. Then use these variables to try to predict the clusters you obtained for the SYMPTOM_TEXT variable.

2. If you have access to a MedDRA program, run the text through that and perform the same tasks with the MedDRA results that you did with the COSTART terms in this book.
Chapter 7

Next Steps: A Quick Look at Additional Features

The %TMFILTER Macro

The %TMFILTER macro is a SAS macro that enables you to convert files into SAS data sets. You can use the macro to perform the following tasks:

- Read documents contained in many different formats (such as PDF and Microsoft Word), convert the files to HTML, and create a corresponding SAS data set that can be used as input for the Text Miner node.
- Retrieve Web pages starting from a specified URL and create a SAS data set that can be used as input for the Text Miner node.
- With the language options, separate your collection by language.

Note: The %TMFILTER macro runs only on Windows operating environments. See Using the %TMFILTER Macro in the Text Miner node documentation for SAS Text Miner 3.1 Java Help for more information.

The %TMPUNC Macro

The %TMPUNC macro strips unwanted punctuation from terms in your document collection. If your documents contain terms with run-on punctuation, such as **people or +bags, these punctuation characters become part of the terms when SAS Text Miner parses the documents. The %TMPUNC macro enables you to convert terms with run-on punctuation by putting spaces before and after the punctuation characters to prevent them from appearing as part of the term. Without the %TMPUNC macro, these two
examples would parse out as two terms, **people** and **bags**. After running the %TMPUNC macro, they would parse as five terms:

- *people*
- *bags*

See Other Macros: %TEXTSYN and %TMPUNC in the Text Miner node documentation for SAS Text Miner 3.1 Java Help for more information.

---

**Tips for Text Mining**

---

**Processing a Large Collection of Documents**

Using the Text Miner node to process a large collection of documents can require a lot of computing time and resources. If you have limited resources, it might be necessary to take one or more of the following actions:

- Use a sample of the document collection.
- Set some of the parse properties to **No**, such as Find Entities, Noun Groups, and Terms in Single Document.
- Reduce the number of SVD dimensions or roll-up terms. If you are running into memory problems with the SVD approach, you can roll up a certain number of terms, and then the remaining terms are automatically dropped.
- Limit parsing to high information words by turning off all parts of speech other than nouns, proper nouns, noun groups, and verbs.
- Structure sentences properly for best results, including correct grammar, punctuation, and capitalization. Entity extraction does not always generate reasonable results.

**Dealing with Long Documents**

SAS Text Miner uses the "bag-of-words" approach to represent documents. That means that documents are represented with a vector that contains the frequency with which each term occurs in each document. In addition, word order is ignored. This approach is very effective for short, paragraph-sized documents, but it can cause a harmful loss of information with longer documents. You may want to consider preprocessing your long documents in order to isolate the content that is really of use in your model. For instance, if you are analyzing journal papers, you may find that analyzing only the abstract gives the best results. Consider using the SAS DATA step or an alternative programming language such as Perl to extract the relevant content from long documents.
Processing Documents from an Unsupported Language or Encoding

If you have a collection of documents from an unsupported language or encoding, you may still be able to successfully process the text and get useful results. Follow these steps:

1. Set the language to English.
2. Turn off these parse properties:
   - Stem Terms
   - Different Parts of Speech
   - Noun Groups
   - Find Entities
3. Run the Text Miner node.

Many of the terms may have characters that do not display correctly, but the Interactive Results window should function and you should be able to create stop lists, start lists, and synonym lists.
Recommended Reading

Here is the recommended reading list for this title:

- Getting Started with SAS Enterprise Miner 5.2
- Getting Started with SAS 9.1 Text Miner

For a complete list of SAS publications, see the current SAS Publishing Catalog. To order the most current publications or to receive a free copy of the catalog, contact a SAS representative at

SAS Publishing Sales
SAS Campus Drive
Cary, NC 27513
Telephone: (800) 727-3228*
Fax: (919) 677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/pubs
* For other SAS Institute business, call (919) 677-8000.

Customers outside the United States should contact their local SAS office.
VAERS Data Preprocessing

The VAERS data for 2002-2006 is read into a SAS data set using a SAS program called Vaers_Import.Sas. This SAS program creates a table called VAERALL. Vaers_Import.Sas is included in the Getting Started with Text Miner 3.1 zip file. For more information about the IMPORT procedure, see SAS OnlineDoc 9.1.3 in the following URL: http://support.sas.com/onlinedoc/913/docMainpage.jsp.

```sas
proc import out= dmtm9.vaers2006
datafile= "d:\vaers files\2006vaersdata.csv"
dbms=csv replace;
getnames=yes;
datarow=2;
run;
proc import out= dmtm9.vaers2005
datafile= "d:\vaers files\2005vaersdata.csv"
dbms=csv replace;
getnames=yes;
datarow=2;
run;
proc import out= dmtm9.vaers2004
datafile= "d:\vaers files\2004vaersdata.csv"
dbms=csv replace;
getnames=yes;
datarow=2;
run;
proc import out= dmtm9.vaers2003
datafile= "d:\vaers files\2003vaersdata.csv"
dbms=csv replace;
getnames=yes;
datarow=2;
run;
proc import out= dmtm9.vaers2002
datafile= "d:\vaers files\2002vaersdata.csv"
dbms=csv replace;
getnames=yes;
datarow=2;
```
run;
proc import out= dmtm9.vaervax2006
  datafile= "d:\vaers files\2006vaersvax.csv"
  dbms=csv replace;
getnames=yes;
  datarow=2;
run;
proc import out= dmtm9.vaervax2005
  datafile= "d:\vaers files\2005vaersvax.csv"
  dbms=csv replace;
getnames=yes;
  datarow=2;
run;
proc import out= dmtm9.vaervax2004
  datafile= "d:\vaers files\2004vaersvax.csv"
  dbms=csv replace;
getnames=yes;
  datarow=2;
run;
proc import out= dmtm9.vaervax2003
  datafile= "d:\vaers files\2003vaersvax.csv"
  dbms=csv replace;
getnames=yes;
  datarow=2;
run;
proc import out= dmtm9.vaervax2002
  datafile= "d:\vaers files\2002vaersvax.csv"
  dbms=csv replace;
getnames=yes;
  datarow=2;
run;
data dmtm9.vaerall;
    dmtm9.vaers2004(drop=datedied hospdays) dmtm9.vaers2005(drop=datedied hospdays)
    dmtm9.vaers2006(drop=datedied hospdays);
run;
data dmtm9.vaervaxall;
run;

The data is then further processed to come up with the extract used in the example:

- The separate COSTART terms are appended into a single COSTRING field for each adverse event.
- Additional indicator variables are created for each of the vaccinations received. In the case of DTP, for example, listed earlier, this would flag both the Pertussis and Diphtheria/Tetanus variables.

The SAS code Vaersetup.Sas used to generate the resulting table, VAEREXT, is in the Getting Started with Text Miner 3.1 zip file.

```sas
libname dmtm9 'd:\emdata\dmtm9';
/*---- TJW Modification: within DATA step ----*/
%macro FixJunk(TextVar=);
```
data dmtm9.vaerext(keep=cage_yr sex symptom_text serious numdays pedflag sym_cnt
  vax_1-vax_16 vax_cnt immun_cnt costring v_adminby v_fundby);
length coterm $25 costring $255;
array syms(20) $ 25 sym01-sym20;
array vaxs(8) $ vax1-vax8;
array nvax{16} vax_1-vax_16;
set dmtm9.vaerall;
/* Only include adverse events that occurred within 90 days of vaccination */
if numdays <= 90;
if cage_yr = . then cage_yr = 0;
if cage_mo = . then cage_mo = 0;
if vax_date ne .;
/* Serious events are ones that required an overnight hospital stay or caused */
/* disability, death, or a life-threatening event */
if l_threat='Y' or died='Y' or hospital='Y' or x_stay='Y' or disable='Y'
  then serious='Y';
else serious='N';
/* Determine age of vaccine recipient -- year + month, mark all those under 9 as pediatric */
cage_yr = cage_yr + cage_mo;
if cage_yr <= 9 then pedflag = 'Y'; else pedflag = 'N';
if died = '' then died = 'N';
if er_visit = '' then er_visit = 'N';
if recovd = '' then recovd = 'U';

/* Since serious adverse events are rare (approx 8%) oversample serious events*/
if serious = 'N' and uniform(0) < .7 then delete;
/* Create flag variables for illnesses frequently innoculated against, also*/
/* count up number of immunizations given at one time to a patient as immun_cnt*/
label vax_1 = 'Anthrax'
    vax_2 = 'Diphtheria/Tetanus'
    vax_3 = 'Flu'
    vax_4 = 'Hepatitis A'
    vax_5 = 'Hepatitis B'
    vax_6 = 'HIB (Haemophilus)' 
    vax_7 = 'Polio (IPV,OPV)'
    vax_8 = 'Measles, Mumps, Rubella'
    vax_9 = 'Meningococcal'
    vax_10 = 'Pneumo (7-valent)'
    vax_11 = 'Pneumo (23-valent)'
    vax_12 = 'Rabies'
    vax_13 = 'Smallpox'
    vax_14 = 'Typhoid'
    vax_15 = 'Pertussis'
    vax_16 = 'Varicella'
;

do i = 1 to 16;
    nvax{i} = 0;
end;
immun_cnt = 0;

/* count up number of immunizations given at one time to a patient as immun_cnt*/
do i = 1 to min(vax_cnt, 8);
    select (vaxs{i});
        when ('6VAX-F') do; 
            vax_2 = 1; 
            vax_5 = 1; 
            vax_6 = 1; 
            vax_7 = 1; 
            immun_cnt = immun_cnt + 5;
        end;
        when ('ANTH') do; 
            vax_1 = 1; 
            immun_cnt = immun_cnt + 1;
        end;
        when ('DPP') do; 
            vax_2 = 1; 
            vax_15 = 1; 
            vax_7 = 1; 
            immun_cnt = immun_cnt + 4;
        end;
        when ('DT', 'DTOX', 'TD', 'TTOX') do; 
            vax_2 = 1; 
            immun_cnt = immun_cnt + 2;
        end;
        when ('DTAP', 'DTP', 'TDAP') do; 
            vax_2 = 1; 
            vax_15 = 1; 
            immun_cnt = immun_cnt + 3;
        end;
        when ('DTAPH', 'DTPHIB') do; 
            vax_2 = 1; 
            vax_15 = 1; 
            immun_cnt = immun_cnt + 3;
        end;
        when ('HEP') do; 
            vax_4 = 1; 
            immun_cnt = immun_cnt + 1;
        end;
        when ('HEPA') do; 
            vax_4 = 1; 
            immun_cnt = immun_cnt + 1;
        end;
end;
when ('HEPAB') do; vax_4=1; vax_5=1; immun_cnt=immun_cnt+2; end;
when ('IPV','OPV') do; vax_7=1; immun_cnt=immun_cnt+1; end;
when ('MEA','MER','MM','MMR','MU','MUR','RUB') do;
   vax_8=1; immun_cnt=immun_cnt+3; end;
when ('MMRV') do; vax_8=1; vax_16=1; end;
when ('MEN','MNC','MNQ') do; vax_9=1; end;
when ('PNC') do; vax_10=1; immun_cnt=immun_cnt+1; end;
when ('PPV') do; vax_11=1; immun_cnt=immun_cnt+1; end;
when ('RAB','RABA') do; vax_12=1; immun_cnt=immun_cnt+1; end;
when ('SMALL') do; vax_13=1; immun_cnt=immun_cnt+1; end;
when ('TYP') do; vax_14=1; immun_cnt=immun_cnt+1; end;
when ('VARCEL') do; vax_16=1; immun_cnt=immun_cnt+1; end;
otherwise;
end;

end;
if immun_cnt > 0;

/* Create a field, costring, with all the constant terms concatenated */
/* together in one string */
costring = '';

do i=1 to min(sym_cnt,20);
   coterm = syms{i};
   costring=trim(costring) || ' ' || trim(coterm);
end;

/* Fix punctuation issues */
%FixJunk(textvar=symptom_text);
run;

proc freq;
   tables pedflag immun_cnt vax_cnt v_adminby v_fundby sex serious vax_1-vax_16;
run;

The following figure shows some columns of the VAEREXT SAS data set that was created by the Vaersetup.Sas code.
<table>
<thead>
<tr>
<th>ID</th>
<th>Event Description</th>
<th>Symptom Description</th>
<th>Serious</th>
<th>Pending</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ANXIETY, CELLULITIS, EDEMA, INJECT SITE REACTION, FEVER, HYPERSENSITIVITY, INFECTED INJECT SITE, LEUKOCYTOSIS, MUSCLE ACHES, PAIN, INJECT SITE, VASODILATATION</td>
<td>Information has been received from an NP concerning a 64-year-old white female who on 1/14/01, at 11:00 AM, was vaccinated IM in the left deltoid with a dose of pneumococcal vaccine (lot 0328637/0400). Within 24 to 36 hours, she developed a fever to 101.5°F. She also developed a rash in the middle of her back, with swelling and redness at the injection site and the skin was hot to the touch and tender. It was approximately the size of a 50-cent piece. It was reported that the pt temperature was not taken.</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>2</td>
<td>ABORTION, LAB TEST ABNORMALITY</td>
<td>Information has been received from an NP concerning a 29-year-old female pt who on an unspecified date was vaccinated with varicella virus vaccine live. The NP indicated that the pt was 2 weeks pregnant when she received the vaccination. No adverse events were reported. Follow-up information was received from a physician assistant who indicated that the pt (gravid 4, parity 3) was vaccinated on 4/13/01 with a dose of varicella virus vaccine live.</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>3</td>
<td>AMNESIA, DELUSIONS</td>
<td>Memory loss, family loss, Mutter and father are dead, Permanent coma, Delusional thoughts of rape, Brain dead, Adopted Birth certificate, Orange Birth certificate, White birth certificate necessary.</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>4</td>
<td>REACT UNEVAL</td>
<td>Subcutaneous vaccines were not good ones. They made your skin and hands papilledoma.</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>
clustering
the process of dividing a data set into mutually exclusive groups so that the observations for each group are as close as possible to one another and different groups are as far as possible from one another. In SAS Text Miner, clustering involves discovering groups of documents that are more similar to each other than they are to the rest of the documents in the collection. When the clusters are determined, examining the words that occur in the cluster reveals the focus of the cluster. Forming clusters within the document collection can help you to understand and summarize the collection without reading every document. The clusters can reveal the central themes and key concepts that are emphasized by the collection.

copyright
finding and displaying the terms that are highly associated with the selected term in the Terms table.

data source
a data object that represents a SAS data set in the Java-based Enterprise Miner graphical user interface (GUI). A data source contains all the metadata for a SAS data set that Enterprise Miner needs in order to use the data set in a data mining process flow diagram. The SAS data set metadata that is required to create an Enterprise Miner data source includes the name and location of the data set; the SAS code that is used to define its library path; and the variable roles, measurement levels, and associated attributes that are used in the data mining process.

diagram
See process flow diagram.

entity
any of several types of information that SAS Text Miner is able to distinguish from general text. For example, SAS Text Miner can identify names (of people, places, companies, or products, for example), addresses (including street addresses, post office addresses, e-mail addresses, and URLs), dates, measurements, currency amounts, and many other types of entities.

libref (library reference)
a name that is temporarily associated with a SAS library. The complete name of a SAS file consists of two words, separated by a period. The libref, which is the first word, indicates the library. The second word is the name of the specific SAS file. For example, in VLIB.NEWBDAY, the libref VLIB tells SAS which library contains the
file NEWBDAY. You assign a libref with a LIBNAME statement or with an operating system command.

**model**

a formula or algorithm that computes outputs from inputs. A data mining model includes information about the conditional distribution of the target variables, given the input variables.

**node**

(1) in the SAS Enterprise Miner user interface, a graphical object that represents a data mining task in a process flow diagram. The statistical tools that perform the data mining tasks are called *nodes* when they are placed on a data mining process flow diagram. Each node performs a mathematical or graphical operation as a component of an analytical and predictive data model. (2) in a neural network, a linear or nonlinear computing element that accepts one or more inputs, computes a function of the inputs, and optionally directs the result to one or more other neurons. Nodes are also known as neurons or units. (3) a leaf in a tree diagram. The terms *leaf*, *node*, and *segment* are closely related and sometimes refer to the same part of a tree. See also process flow diagram.

**parse**

to analyze text for the purpose of separating it into its constituent words, phrases, multiword terms, punctuation marks, or other types of information.

**partition**

to divide available data into training, validation, and test data sets. See also training data, validation data, and test data.

**process flow diagram**

a graphical representation of the various data mining tasks that are performed by individual Enterprise Miner nodes during a data mining analysis. A process flow diagram consists of two or more individual nodes that are connected in the order in which the data miner wants the corresponding statistical operations to be performed.

**roll-up terms**

the highest-weighted terms in the document collection.

**SAS data set**

a file whose contents are in one of the native SAS file formats. There are two types of SAS data sets: SAS data files and SAS data views. SAS data files contain data values in addition to descriptor information that is associated with the data. SAS data views contain only the descriptor information plus other information that is required for retrieving data values from other SAS data sets or from files whose contents are in other software vendors’ file formats.

**score**

the process of applying a model to new data in order to compute output. Scoring is the last process that is performed in data mining.

**segmentation**

the process of dividing a population into subpopulations of similar individuals. Segmentation can be done in a supervisory mode (using a target variable and various techniques, including decision trees) or without supervision (using clustering or a Kohonen network).

**singular value decomposition**

a technique through which high-dimensional data is transformed into lower-dimensional data.
stemming
the process of finding and returning the root form of a word. For example, the root form of grinds, grinding, and ground is grind.

stop list
a SAS data set that contains a simple collection of low-information or extraneous words that you want to remove from text mining analysis.

test data
currently available data that contains input values and target values that are not used during training, but which instead are used for generalization and to compare models. See also training data and test data.

training data
currently available data that contains input values and target values that are used for model training. See also test data and validation data.

validation data
data that is used to validate the suitability of a data model that was developed using training data. Both training data sets and validation data sets contain target variable values. Target variable values in the training data are used to train the model. Target variable values in the validation data set are used to compare the training model's predictions to the known target values, assessing the model's fit before using the model to score new data. See also test data and training data.

variable
a column in a SAS data set or in a SAS data view. The data values for each variable describe a single characteristic for all observations. Each SAS variable can have the following attributes: name, data type (character or numeric), length, format, informat, and label.
### Index

| A | accessibility features 5 |
|   | Automatically Cluster property 22 |
| C | cleaning data 33 |
|   | creating a stop list 27 |
|   | creating a synonym data set 53 |
|   | examining results using merged synonym data sets 46 |
|   | exploring result improvements 46 |
|   | using a synonym data set 35 |
|   | Cluster properties 22 |
|   | clusters 65 |
|   | concept linking 65 |
|   | converting files into data sets 65 |
| COSTART coding system 51 |
| COSTART Terms node 51 |
| COSTRING variable 51 |
| D | data cleaning  |
|   | See cleaning data  |
|   | Data Partition node 20 |
|   | data segments 28 |
|   | data sets  |
|   | converting files into 65 |
|   | importing 33 |
|   | merged synonym data sets 40 |
|   | synonym data sets 35 |
|   | data source  |
|   | creating for projects 14 |
|   | Descriptive Terms property 22 |
|   | diagrams 18 |
|   | creating 21 |
|   | Different Parts of Speech property 21 |
|   | document requirements 1 |
|   | documents  |
|   | from unsupported language or encoding 67 |
|   | large collection of 60 |
|   | long 60 |
| E | encoding, unsupported 67 |
| F | files  |
|   | converting into data sets 65 |
| H | Help 10 |
| I | Ignore Outliers property 23 |
|   | Ignore Parts of Speech property 21 |
|   | importing data sets 33 |
|   | input data  |
|   | identifying 19 |
|   | partitioning 20 |
|   | interactive results 23 |
|   | viewing 23 |
| L | languages, unsupported 67 |
|   | large collection of documents 60 |
|   | long documents 60 |
| M | MedDRA program 64 |
|   | merged synonym data sets 40 |
|   | misspelled terms 77 |
|   | Model Comparison node 61 |
|   | modeling  |
|   | See predictive modeling  |
| N | node properties 20 |
| P | Parse properties 23 |
|   | Parse Variable 23 |
|   | partitioning input data 20 |
|   | path for projects 13 |
|   | predictive mining 51 |
|   | predictive modeling 61 |
|   | comparing models 51 |
|   | COSTRING variable for 51 |
Your Turn

We want your feedback.

• If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).
• If you have comments about the software, please send them to suggest@sas.com.
SAS® Publishing gives you the tools to flourish in any environment with SAS!

Whether you are new to the workforce or an experienced professional, you need to distinguish yourself in this rapidly changing and competitive job market. SAS® Publishing provides you with a wide range of resources to help you set yourself apart.

SAS® Press Series
Need to learn the basics? Struggling with a programming problem? You’ll find the expert answers that you need in example-rich books from the SAS Press Series. Written by experienced SAS professionals from around the world, these books deliver real-world insights on a broad range of topics for all skill levels.

SAS® Documentation
To successfully implement applications using SAS software, companies in every industry and on every continent all turn to the one source for accurate, timely, and reliable information—SAS documentation. We currently produce the following types of reference documentation: online help that is built into the software, tutorials that are integrated into the product, reference documentation delivered in HTML and PDF—free on the Web, and hard-copy books.

SAS® Learning Edition 4.1
Get a workplace advantage, perform analytics in less time, and prepare for the SAS Base Programming exam and SAS Advanced Programming exam with SAS® Learning Edition 4.1. This inexpensive, intuitive personal learning version of SAS includes Base SAS® 9.1.3, SAS/STAT®, SAS/GRAPH®, SAS/QC®, SAS/ETS®, and SAS® Enterprise Guide® 4.1. Whether you are a professor, student, or business professional, this is a great way to learn SAS.

support.sas.com/saspress
support.sas.com/publishing
support.sas.com/LE